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Introduction

Introduction

Students of mathematics today grapple with ideas that have taken hundreds of years for
Western society to discover. Although European society was introduced to place-value
notation in the 12th century, students today learn about place value in the first grade.
While it wasn't until 1600 that Europeans for the most part abandoned Roman numerals
and began using present-day notation for numbers, fifth and sixth graders today not only
use place-value notation but also study decimals and fractions. While set theory wasn't
invented until almost 1900, the topic is a staple for today's early algebra students.

Because most children will not discover intellectual tools like place value or set theory on
their own, many educators falsely conclude that students are incapable of any discovery in
mathematics and science. In our haste to move centuries of knowledge from textbooks into
the heads of students, we sometimes resort to what psychologist Jean Piaget described as
“premature formalization,” introducing knowledge in a final, polished form. We all know
the symptoms. Geometric proofs and algebraic laws are laid out in black and white, wait-
ing to be memorized. Algorithms and procedures are presented, then expected to be imme-
diately used in computations. Children “incapable of discovery” are spared the trouble of
having to think for themselves. Getting the right answer is given priority over understand-
ing.

Not so in Divide and Conquer, a program based on the premise that most children can
discover mathematical ideas given the proper circumstances. Divide and Conquer, for grades
4 on up,  proves that the process of discovery can be challenging and exciting in itself, with
little or no need for extrinsic rewards.

Macintosh Game Screen
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• form hypotheses
• think about relationships among numbers
• look for patterns
• reason logically
• exchange opinions

What is Divide and Conquer?

Divide and Conquer is a code-breaking activity in which ten symbols stand for the numbers 0
through 9. The student's goal is to discover which number each symbol stands for in a
given game. The program first chooses a dividend and displays it, then students enter a
divisor of their choice. Using the results that the program calculates, the students gradually
deduce which number each letter must represent. Although the computer calculates the
quotient and remainder, some of the numbers are in code. It’s really the code-breaker who
must “divide and conquer.”

Math and Learning Objectives

From the student’s point of view, the sessions are about adding, subtracting, multiplying,
and dividing. The sessions, however, go well beyond simple arithmetic. Through using
Divide and Conquer, students are encouraged to:

Teaching Strategies

Knowing how to teach mathematics is inherently complex. Sometimes the best way to
stimulate students’ appetite for learning is to provide a little food for thought and then let
them ruminate for a while on their own. In the right setting, Divide and Conquer can provide
this food for thought. The program can be used effectively in a lab setting, in small groups,
or in front of the whole class. The teacher's role changes in response to the changing
setting, and can include:

• motivating students and encouraging them to be reflective
• establishing a favorable intellectual and social climate
• coordinating discussion
• acting as a skilled interviewer to elicit desirable lines of reasoning

Rather than being a source of answers, the teacher raises issues in a Socratic style for the
students to think about. For ideas about how to engage students in discussion about
mathematical issues related to Divide and Conquer, see “Learning with Divide and
Conquer” (page 33). Pay attention to how the interviewer helps the children clarify their
thinking without suggesting answers. Look also at “Hints for Levels 5 to 8” (page 46) and
“Off-Computer Problems” in the Student Pages (pages 49-51).
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Through exercising their thinking and reasoning skills, students can come to realize the
essential role that discovery plays in the field of mathematics. There are several specific
mathematical discoveries students might make on their own in the course of play in order
to solve problems. Because they are so useful to the goal of cracking the code, these are also
the principles a teacher might use to guide students towards deducing. (Of course, present-
ing them as facts to be memorized would undermine the purpose of the program.)  Coming
to realize any one of them fosters the process of discovery, which is then intrinsically re-
warded through the increased success with which a student can play. More detail on each
principle can be found in “Learning with Divide and Conquer” (page 33).  Please note that
the examples which follow and the game itself share the convention that a coded number,
such as GL, does not mean G x L but, rather, stands for a two-digit number such as 75 or
19.

Discoveries

• Inverse — The product of a divisor and a quotient, plus a remainder, yields the
dividend.
E.g., “MS ÷ 2 yields 34 remainder 1” implies 2 x 34 + 1 = MS. Conclusion:  M = 6,
S = 9.

• Remainder Smaller than Divisor — For all cases of division with a remainder, the
remainder must be less than the divisor.
E.g., “XL ÷ 2 yields 12 remainder B” implies B < 2. Conclusion:  B = 0 or B = 1.

• First Special Property of Ten — A two-digit number, divided by 10, yields a
quotient of the first digit and a remainder of the second digit.
E.g., “MU ÷ 10 yields 7 remainder U” implies M = 7; or

“MU ÷ 10 yields M remainder 3” implies U = 3.

• Second Special Property of Ten — A two-digit number divided by a one-digit
number, yielding 10 as the quotient, must have the divisor as the first digit.
E.g., “MU ÷ 6 yields 10 remainder U” implies M = 6.

• Division by One — Dividing a number by 1 yields the number itself as quotient
and a remainder of 0. This follows from the fact that 1 is an “identity operator.”
E.g., “AT ÷ 1 yields 39 remainder W” implies A = 3, T = 9, W = 0.

• Division by Dividend Itself — A number divided by itself gives a quotient of 1
and a remainder of 0.
E.g., “AT ÷ AT yields X remainder W” implies X = 1, W = 0.

• Divisor Larger than Dividend — Dividing by a number larger than the dividend
produces a quotient of 0 and a remainder equal to the dividend.
E.g., “AG ÷ 75 yields 0 remainder 23” implies AG = 23. Conclusion:  A = 2, G = 3.
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• Divisor Larger than Half the Dividend — When the divisor is larger than half the divi-
dend, the quotient is 1 and the remainder is the difference between the dividend and the
divisor but equal or less than the dividend.
E.g., “94 ÷ BN yields 1 remainder 8” implies BN = 86. Conclusion:  B = 8, N = 6.

How Divide and Conquer  was Developed
In interactions with the world—in supermarkets, shops, homes and offices—adults use an
informal or intuitive mathematics that is somewhat different from mathematics as it is
taught in school. This holds for adolescents and even more so for young children, who
develop the foundations of many mathematical and logical concepts out of school. Students
of all ages bring their informal mathematical knowledge into the classroom but are only
occasionally given the opportunity to reflect upon it and use it to solve problems.

Divide and Conquer arose out of studies in the area of informal learning. During a 1988-89
sabbatical visit to the Shell Centre For Mathematical Education in Nottingham, England, I
designed Divide and Conquer to help grade schoolers use their informal mathematical
understanding and logic to gain insight into how our number system is structured.  In
1989, two classes of 10- and 11-year-olds from Dunkirk Primary School in Nottingham took
part in a pilot study, with the gracious support of their teacher, Mrs. Pat Thorpe. The
children’s enthusiasm for Divide and Conquer was striking and the interviews conducted in
England provided a first look at the kinds of math principles children were discovering.

During 1989-90, at the Laboratory for Educational Software at the Federal University of
Pernambuco in Recife, Brazil, Dr. Analucia Schliemann and I conducted systematic studies
with Brazilian 11-, 12-, 15- and16-year-olds using Divide and Conquer. It was instructive to
see the great similarities in how English and Brazilian students approached the activities.
The studies conducted in England and Brazil helped us understand how students reason
and represent ideas while using Divide and Conquer. Many of these insights are
incorporated in this manual.

We invite other teachers to share with us their students’ responses to the software and,
especially, their insights into how children think.
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Installation

Installing and Running Divide and Conquer On the Macintosh

1. Turn on the computer and place the CD in the CD-ROM drive.
2. Drag the Divide and Conquer folder from the CD to your hard drive.
3. To run the software, double-click the Divide and Conquer application icon in the

Divide and Conquer folder on your hard drive.  You do not need the CD in the CD-
ROM drive to use the software.

Installing and Running Divide and Conquer On Windows 3.1

1. Turn on the computer and place the CD in the CD-ROM drive.
2. Select Run from the File menu in the Program Manager.
3. At the prompt, type d: setup.exe, where d is the letter of your CD-ROM drive.
4. Follow the on-screen directions to complete the installation.
5. When installation is complete, double-click the Divide and Conquer program item in

the Sunburst directory or the directory you chose during installation.  You do not
need the CD in the CD-ROM drive to use the software.

Installing and Running Divide and Conquer On Windows 95

1. Turn on the computer and place the CD in the CD-ROM drive.
2. Select Run from the Start menu.
3. At the prompt, type d: setup.exe, where d is the letter of your CD-ROM drive.
4. Follow the on-screen directions to complete the installation.
5. When installation is complete, select  Divide and Conquer from the Sunburst group in

the Start menu's Programs menu, or the group you chose during installation.  You
do not need the CD in the CD-ROM drive to use the software.

Troubleshooting for Windows 3.1 and Windows 95

When you first launch Divide and Conquer, the Sunburst logo should appear, followed by a
title screen displaying "Divide & Conquer" in large yellow letters on a blue background.
Should the program fail to display this sequence, you will need to exit the program and
install the font dccodes.ttf by hand.

To install the font in Windows 3.1, open the Control Panels in the Main directory.  Select
Fonts and Add.  A dialog will appear.  Select the file dccodes.tiff from the directory
DANDC or the directory you selected when installing Divide and Conquer.  Click OK.
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Exit Windows, and then restart by typing win and pressing enter.  Launch Divide and
Conquer.

To install the font in Windows 95, choose Control Panel from the Settings group in the Start
menu.  Double-click the Fonts group.  In the Fonts window, select Install New Font from
the File menu.  A dialog will appear.  Select the file dccodes.tiff from the directory
DANDC, or the directory you selected when installing Divide and Conquer.  Click OK.
Exit and restart Windows.  Launch Divide and Conquer.
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Getting Started

Working with Divide and Conquer

Divide and Conquer is a code-breaking activity where code symbols stand for the numbers
zero through nine. The screen below is an example of a session in progress.

The Dividend Area in the upper left corner displays the dividend the computer chooses.
Although the program always selects the dividend, the player may ask for a new selection
at any time by choosing Change dividend under the File menu(Macintosh) or Options menu
(Windows).

The program divides the dividend by the number or code the player enters into the Divisor
Box, to the right of the Dividend Area.

The division problem and solution appear in the Results Area in the lower left-hand corner.
Using the data, the player can formulate and test hypotheses concerning the code symbols
and ultimately enter digits into the Codes Area where the ten code symbols are displayed.
The session is complete when all code symbols have been correctly decoded.

Macintosh Game Screen
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Moving Through a Sample Session

At the start of Divide and Conquer, the program displays a dividend in the Dividend Area
and code symbols that correspond to numbers 0-9 in the Codes Area. Here, the dividend 72
has been chosen by the program.

Codes Area

Hypothesis AreaResults Area

To begin breaking the code, enter divisors and interpret the solutions generated by the
program. Click in the Divisor box, enter the divisor (a number up to three digits long), and
press return. The division problem appears in the Results Area, along with the answer
calculated by the program. In the Rookie level, which is the default level of play, this an-
swer appears in code symbols.

In the screen shown above, 5 has been entered as the divisor. Examine the result. Can the
results be used to decode any of the letters? If so, enter the numbers into the Codes Area.
There is, in fact, enough information to identify the three letters in this example.

Macintosh Game Screen

Macintosh Game Screen
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As symbols are decoded, move the cursor to the Codes Area and click the mouse under the
appropriate symbol. Type in your guess. If it is correct, a bell will sound, and the number
will appear underneath its code symbol. If it is incorrect, a “clank” sound will occur, and a
number will not appear. The example below demonstrates a screen after a correct answer
(1, 2 and 4 in this case) was entered in the Codes Area.

Now enter a new divisor, using any information gained from the previous solution, and
interpret the new result. Play continues in this way—entering new divisors, interpreting
the solutions the program calculates and identifying the numbers the code symbols repre-
sent—until all ten code symbols have been correctly deciphered.

There are eight levels of difficulty. At the Rookie level, in the above example, the solution
can be found in a straightforward manner. The remaining levels use variations in the ele-
ments that are coded and uncoded and place constraints on the allowable divisors. These
variations are simple enough that the same procedure still applies to every level; yet they
produce dramatic changes in the perspective students must take to “crack the code,” pro-
voking new insights about the number system.

Macintosh Game Screen
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Program Description – Macintosh

The Getting Started section outlines the basics of playing Divide and Conquer. During the course
of the program, students may want to choose additional options that will help them progress
towards decoding the symbols. These options can be found in the File menu.

The File Menu

New Game

To leave a session and begin a new one, choose New Game or press �    - N. A fresh screen
will appear. The code symbols are now reassigned to different numbers, and the level of
play remains the same as the previous session.

Show discovered numbers...

Each new session begins with the default setting Show
discovered numbers ... never. This setting retains the coded
items in the Results Area even after they have been prop-
erly decoded in the Codes Area.

The information in the Results Area may be interpreted more easily if all the deciphered
code symbols are represented as numbers rather than code. Select Show discovered numbers ...
to this point to replace the coded items for each division problem entered through this point
in the session with their correctly identified numbers.

If a student would like this feature throughout the entire session, select Show discovered
numbers ... always. Once a code has been deciphered, that number is unencrypted anywhere
it appears in the Results Window through this point and for the remainder of the session, or
until ... always is deselected. A check mark will appear by the chosen setting.
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For example, the Codes Area shown below indicates that the student has decoded "X," "B"
and “S” as representing 2, 0 and 1 respectively. Because ... to this point or ... always has been
selected, the letters that have been decoded are replaced by their numerical values in the
Results Area. Otherwise, if left in the default setting ... never, the coded symbols would
continue to remain in each division problem in the Results Area.

Change dividend

Students may change the current dividend at any time within an active session by selecting
Change dividend. This varies the information already provided. When the dividend is
changed the code associated with each number remains the same, but the student is given a
different perspective. (i.e., If the dividend is 39 and “A=2”, then “A=2” even when the
dividend becomes 99 or 139. The code and number associated remains constant.)

Hypothesize...

As the range of possible numerical values of a particular code symbol narrows, students
may wish to test their conjectures by selecting Hypothesize... A new window will open, listing
the set of code symbols (use the scroll bar to view all of the choices) and 4 possible hypoth-
eses. This window will also appear by clicking on the Hypothesis Area below the Codes
Area.



Program Description

Divide and Conquer 9

As new symbol combinations are introduced into the Results Area, they are added to the list
in the Hypothesis Window. In the example above, “FV” was part of a solution in the Results
Area and therefore was added onto the scrolled list in the Hypothesis Window.

To make a hypothesis, select a symbol and a hypothesis by clicking on each one. (In the
example below, the symbol “F” and the button corresponding to “is odd” were clicked.)
Click OK. The Hypothesis Window will close and the hypothesis, followed by a truth
statement, will appear in the Hypothesis List of the Divide and Conquer Main Window.

There are 4 hypotheses to choose from. If a student selects “less than...” or “equal or
greater than...” a dialog box will appear. A number or code may be entered here to
complete the statement.

Note: to enter a Greek letter or a picture, it is best to use the keypad (see page 16 for the
English equivalent of the Greek letters and page 11 for keypad use).
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Once a symbol and a complete hypothesis have been selected, click OK. The Hypothesis
Window will close and the hypothesis, followed by a truth statement, will appear in the
Hypothesis List of the Divide and Conquer Main Window.

Quit

To end a session, select Quit or press �   - Q.

The Settings Menu

Use the Settings menu to change the level of play or
alter some of the program’s features.

Status

To monitor their progress, students may select Status. This option presents the following
information in a Status Window located in the upper right-hand corner of the screen:

• the level of play,
• how many clues were used, and
• how many times a student's decoding effort was

correct or incorrect.

Once Status is selected, the information will remain on the screen until the option is
deselected from the Settings menu. A check mark will appear next to Status when it is
active.
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KeyPad

When this option is selected a keypad will appear below the Divide and Conquer Main
Window. (This option may be selected only when the Main Window is displayed and
the Hypothesis Window is closed.) A student can enter the divisor, identify a code, or
make an entry in the Hypothesis entry field by clicking on the appropriate code symbol
or number and clicking OK. The opening KeyPad Window always defaults to code
symbols. The Arrow button on the left toggles the keypad from code symbols to num-
bers. The Clear button erases the student's choice so another code symbol or number
can be entered.

This option may make it easier for younger students who are unfamiliar with the Ma-
cintosh keyboard to use Divide and Conquer with little interruption.

Set level

The difficulty level can be set at any
point during the program; however,
changing the level mid-session forces the student to start a new
session. When Set level is selected a submenu opens, offering a
choice of eight play levels, a demonstration level and an Auto
Advance Levels option. A check mark will appear next to the
selected level of play.

0. Demonstration

The Demonstration level familiarizes new students
with the program. At this level, the Codes Area is
inoperative because students will not actually solve
problems. They will, however, be presented with a
dividend, so they may practice entering a divisor and
seeing the results displayed. (This procedure is ex-
plained in the Getting Started section on pages 3-4.)

Settings Menu
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1. Rookie

The Rookie level corresponds roughly to "division
with a remainder" that students learn in primary
school. At this level, the dividend is a two-digit
number, and the quotient and remainder are given in
code. In this and each of the next three levels, the
divisor may be any number or code up to three digits
long. Rookie level problems can be solved by doing
division with a remainder and matching the results
to the coded result on the computer screen.

2. Apprentice

At the Apprentice level, the program encodes the
dividend and gives the quotient and remainder in
numbers. Thus, the perspective shifts since it is no
longer possible to solve the problem by dividing. Most
students will soon discover they can break the code by
making use of multiplication and addition.

3. Master

At the Master level, both the dividend and remain-
der are in code. The program then becomes more
challenging; the results derived from entering one
divisor are not usually sufficient for determining the
values of the code symbols generated in that prob-
lem. It  becomes clear that students cannot continue
to be successful simply by making numerical compu-
tations. To make sense of the answers, they must
draw upon their intuition and knowledge of numbers. Students must now carry out
several division problems and reflect upon the results.

Settings Menu
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4. Expert

The Expert level encodes the dividend and the quo-
tient. The same type of problem solving is exercised as
in the Master level, but the Expert level is made more
demanding by a new constraint:  the student cannot
multiply the quotient by the divisor to get a rough
estimate of the dividend.

5. Ace

The Ace level is still more difficult; the dividend,
quotient and remainder are all in code. Furthermore,
whereas in all the previous levels the divisor could
be any number or code up to three digits, the divisor
can now be a one- or two-digit number or code only.
Some students may even remark that this level is
“impossible.” But as unlikely as it might seem, they
will begin to draw conclusions from what initially
looked like a meaningless list of codes on the screen.

6. Wizard

The Wizard level resembles the Ace level with the
addition that dividends of three places are used. How-
ever, you may not use “10” or code symbols as divisors
at this level.

7. Inspired

At the Inspired level, the dividend is again a three-
digit code. The program reveals the number of places
in the quotient but not the code symbols for the
individual digits of the quotient.

Settings Menu
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8. Phantom

The Phantom level is the most challenging. Again, the
dividend is a three-digit code. However, the only infor-
mation provided in the answer is the numerical remain-
der. No information whatsoever is provided regarding
the quotient.

Auto Advance Levels

Auto Advance Levels may be selected if a student wishes to play all 8 levels in order,
beginning with the Rookie level. This option automatically advances students to a new
activity on the next level once the current activity has been successfully completed, thus
giving students one continuous session of Divide and Conquer.

Settings Menu
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Apprentice

Master

Expert

Ace

Wizard

Phantom

Level Dividend Divisor Quotient

Demonstration

Rookie

Inspired

2 digit number up to 3-digit number

2 digit number

2 digit code

2 digit code

2 digit code

2 digit code

number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

1- or 2-digit
number or symbol

number

number

code

code

code

57 4

57 12

12

12

12

4

4

P

P

P

MC

MC

MC

number, excl.10

3 digit code

3 digit code

number
1- or 2-digit

1- or 2-digit

number of
digits only

no information

• •• •• •• •• •

?

MMC

MMC

3 digit code
1- or 2-digit

number, excl.10 code

NTMMC

12 ÷

 ÷

 ÷

 ÷

 ÷

 ÷

 ÷

 ÷

7

7

→

→

→

→

→

7 →

→

→

number

number

number

code

code

code

9

J

9

J

number

number

4

4

code

M

V
ariation

s on
 57 ÷ 12 →

 4 rem
ain

d
er 9

           V
ariation

s on
 445 ÷ 7 →

 63 rem
ain

d
er 4

Play Levels Summary

This table summarizes the representation of figures and constraints on the types of
divisors permissible at each level. An example is given for each level, followed by a
description of the allowable representation of the figures in the equation.

Keep these general conventions in mind:
• alphabetical order has no relation to the numbers that code symbols represent, nor

does their displayed order; and
• code symbols displayed next to each other stand for the digits in a multiple-digit

number, not for their multiplicative product.

Settings Menu

MC 12 ÷ 9→

J
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Change code symbols

Divide and Conquer uses English letters by
default, but you may elect to use Greek
letters or pictures instead. Select Change
code symbols to view a sub-menu of these
options. Changing code symbols mid-
session results in having to begin a new
session.

Greek

Of the 24 letters in the Greek alphabet, Divide and Conquer uses 14. The available Greek
letters are listed with their pronunciation and English keyboard equivalents.

Greek Pronounced English Greek Pronounced English

α alpha a µ mu m
β beta b π pi p
γ gamma g ρ rho r
δ delta d σ sigma s
ε epsilon e τ tau t
η eta h ψ psi y
λ lambda l ω omega w

Pictures

The keypad below shows the available pictures. You may wish to make up names for
them. Use the KeyPad option to enter the pictures into the divisor field, code area or
hypothesis entry field.

Turn off sound

This option disables sound—a high-pitched bell for correct guesses, a “clank” for incor-
rect ones and an ascending sequence of notes when a game has been successfully com-
pleted. The sound option acts as a toggle switch. When sound is on, the option reads
Turn off sound. When sound is off, the option reads Turn on sound.

Settings Menu
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Program Description – Windows

The Getting Started section outlines the basics of playing Divide and Conquer. During the course
of the program, students may want to choose additional options that will help them progress
towards decoding the symbols. These options can be found in the Options menu.  A brief
description of the different menus follows.

    The File Menu

New

To leave a session and begin a new one, choose New. A fresh screen will
appear. The code symbols are now reassigned to different numbers, and
the level of play remains the same as the previous session.

Open...

To leave a session and open a saved one, choose Open.  Select the name
of the session you want.

Save

To save a session, choose Save.  You will be prompted to give the session a name.

Save As...

To save a session with a new name, choose Save As.

Print

To print a report of the current game, choose Print.

Exit

To leave the program, choose Exit.



Program Description

18 Divide and Conquer

Once Status is selected, the information will remain on the screen until the option is
deselected from the Options menu.  A check mark will appear next to Status when it is
active.

Keypad

When this option is selected a keypad will appear on the lower left. (This option may be
selected only when the Main Window is displayed and the Hypothesis Window is
closed.)  A student can enter a divisor, identify a code, or make an entry in the Hypoth-
esis entry field by clicking on the appropriate code symbol or number and clicking on
OK.  The opening Keypad Window always defaults to code symbols.  The Arrow button
toggles the keypad from code symbols to numbers.  The Clear button erases the
student's choice so another code symbol or number can be entered.

This option may make it easier for younger students to use Divide and Conquer with little
interruption.

The Options Menu

Status

To monitor their progress, students may
select Status.  This option presents the
following information in a Status Window
located in the lower right corner of the screen:

• the level of play
• how many clues were used
• how many times a student's decoding effort was correct or incorrect.
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Show discovered numbers

Each new session begins with the
default setting Show discovered
numbers ... Never. This setting
retains the coded items in the
Results Area even after they have
been properly decoded in the
Codes Area.

The information in the Results
Area may be interpreted more easily if all the deciphered code symbols are represented as
numbers rather than code. Select Show discovered numbers ... To This Point to replace the
coded items for each division problem entered through this point in the session with their
correctly identified numbers.

If a student would like this feature throughout the entire session, select Show discovered
numbers ... Always. Once a code has been deciphered, that number is unencrypted anywhere
it appears in the Results Window through this point and for the remainder of the session, or
until ... Always is deselected. A check mark will appear by the chosen setting.

For example, the Codes Area shown below indicates that the student has decoded "V," "S,"
"E," "W," and “N” as representing 3, 6, 5, 2, and 1 respectively. Because ... To This Point or ...
Always has been selected, the letters that have been decoded are replaced by their numerical
values in the Results Area. Otherwise, if left in the default setting ... Never, the coded sym-
bols would continue to remain in each division problem in the Results Area.



Program Description

20 Divide and Conquer

As new symbol combinations are introduced into the Results Area, they are added to the list
in the Hypothesis Window.

To make a hypothesis, select a symbol and a hypothesis by clicking on each one. (In the
example below, the symbol “X” and the button corresponding to “is even” were clicked.)
Click on OK. The Hypothesis Window will close and the hypothesis, followed by a truth
statement, will appear in the Hypothesis List of the Divide and Conquer Main Window.

Hypothesize

As the range of possible numerical values of a particular code symbol narrows, students
may wish to test their conjectures by selecting Hypothesize. A new window will open, listing
the set of code symbols (use the scroll bar to view all of the choices) and 4 possible hypoth-
eses. This window will also appear by clicking on the Hypothesis Area below the Codes
Area or by clicking on the Hypothesize button.
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There are 4 hypotheses to choose from.  A student who selects “less than...” or “greater
than...” must enter a number or code to complete the statement.

Note: to enter a Greek letter or a picture, it is best to use the keypad (see page 22 for the
English equivalent of the Greek letters and page 18 for keypad use).

Once a symbol and a complete hypothesis have been selected, click on OK. The Hypoth-
esis Window will close and the hypothesis, followed by a truth statement, will appear in
the Hypothesis List of the Divide and Conquer Main Window.
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Change Dividend

Students may change the current dividend at any time within an active session by selecting
Change Dividend or by clicking the Change Dividend button. This varies the information
already provided. When the dividend is changed the code associated with each number
remains the same, but the student is given a different perspective. (i.e., If the dividend is 39
and “A=2”, then “A=2” even when the dividend becomes 99 or 139. The code and number
associated remains constant.)

Sound On

This option controls sound – a high-pitched bell for correct guesses, a "clank" for incorrect
ones, and an ascending sequence of notes when a game has been successfully completed.
The sound option acts as a toggle switch.  When sound is on, the option has a check mark
next to it.  When sound is off, the option does not have a checkmark next to it.

Auto Advance Levels

Auto Advance Levels may be selected if a student wishes to play all 8 levels in order,
beginning with the Rookie level.  This option automatically advances students to a new
activity on the next level once the current activity has been successfully completed, thus
giving students one continuous session of Divide and Conquer.

The Codes Menu

Divide and Conquer uses English letters by default, but you may elect to
use Greek letters or pictures instead.  Select the Codes menu to view these
options.  Changing code symbols mid-session results in having to begin a
new session.

Greek

Of the 24 letters in the Greek alphabet, Divide and Conquer uses 14.  The available Greek
letters are listed with their pronunciation and English equivalents.  Use the Keypad to enter
Greek letters into the divisor field or hypothesis field.

Greek Pronounced English Greek Pronounced English

α alpha a µ mu m
β beta b π pi p
γ gamma g ρ rho r
δ delta d σ sigma s
ε epsilon e τ tau t
η eta h ψ psi y
λ lambda l ω omega w
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Pictures

The keypad below shows the available pictures. You may wish to make up names for
them. Use the Keypad to enter the pictures into the divisor field or hypothesis  field.

The Levels Menu

The difficulty level can be set at any point during the program;
however, changing the level mid-session forces the student to
start a new session. The Levels menu offers a choice of eight
play levels and a demonstration level. A check mark appears
next to the selected level of play.

0. Demonstration

The Demonstration level familiarizes new students with the program. At this level,
the Codes Area is inoperative because students will not actually solve problems. They
will, however, be presented with a dividend, so they may practice entering a divisor
and seeing the results displayed. (This procedure is explained in Getting Started.)
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1. Rookie

The Rookie level corresponds roughly to
"division with a remainder" that students learn
in primary school. At this level, the dividend is
a two-digit number, and the quotient and
remainder are given in code. In this and each of
the next three levels, the divisor may be any
number or code up to three digits long. Rookie
level problems can be solved by doing division
with a remainder and matching the results to
the coded result on the computer screen.

2. Apprentice

At the Apprentice level, the program encodes the
dividend and gives the quotient and remainder in
numbers. Thus, the perspective shifts since it is no
longer possible to solve the problem by dividing.
Most students will soon discover they can break the
code by making use of multiplication and addition.

At the Master level, both the dividend and
remainder are in code. The program then
becomes more challenging; the results
derived from entering one divisor are not
usually sufficient for determining the values
of the code symbols generated in that prob-
lem. It  becomes clear that students cannot
continue to be successful simply by making
numerical computations. To make sense of
the answers, they must draw upon their
intuition and knowledge of numbers. Students
must now carry out several division problems
and reflect upon the results.

3. Master
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4. Expert

The Expert level encodes the dividend and the
quotient. The same type of problem solving is
exercised as in the Master level, but the Expert level
is made more demanding by a new constraint:  the
student cannot multiply the quotient by the divisor
to get a rough estimate of the dividend.

5. Ace

The Ace level is still more difficult; the divi-
dend, quotient and remainder are all in code.
Furthermore, whereas in all the previous levels
the divisor could be any number or code up to
three digits, the divisor can now be a one- or
two-digit number or code only. Some students
may even remark that this level is “impos-
sible.” But as unlikely as it might seem, they
will begin to draw conclusions from what
initially looked like a meaningless list of codes
on the screen.

6. Wizard

The Wizard level resembles the Ace level with the
addition that dividends of three places are used.
However, you may not use “10” or code symbols as
divisors at this level.
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7. Inspired

At the Inspired level, the dividend is again a three-
digit code. The program reveals the number of
places in the quotient but not the code symbols for
the individual digits of the quotient.

8. Phantom

The Phantom level is the most challenging.
Again, the dividend is a three-digit code.
However, the only information provided in the
answer is the numerical remainder. No infor-
mation whatsoever is provided regarding the
quotient.
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Apprentice

Master

Expert

Ace

Wizard

Phantom

Level Dividend Divisor Quotient

Demonstration

Rookie

Inspired

2 digit number up to 3-digit number

2 digit number

2 digit code

2 digit code

2 digit code

2 digit code

number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

up to 3-digit
number or symbol

1- or 2-digit
number or symbol

number

number

code

code

code

57 4

57 12

12

12

12

4

4

P

P

P

MC

MC

MC

number, excl.10

3 digit code

3 digit code

number
1- or 2-digit

1- or 2-digit

number of
digits only

no information

• •• •• •• •• •

?

MMC

MMC

3 digit code
1- or 2-digit

number, excl.10 code

NTMMC
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 ÷

 ÷
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 ÷

 ÷

7

7

→

→

→

→

→

7 →

→

→

number

number

number

code

code

code

9

J

9

J

number

number
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4
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M
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MC 12 ÷ 9→

J

Play Levels Summary

This table summarizes the representation of figures and constraints on the types of
divisors permissible at each level. An example is given for each level, followed by a
description of the allowable representation of the figures in the equation.

Keep these general conventions in mind:
• alphabetical order has no relation to the numbers that code symbols represent, nor

does their displayed order; and
• code symbols displayed next to each other stand for the digits in a multiple-digit

number, not for their multiplicative product.

Remainder
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The Help Menu

About Divide and Conquer...

This option brings up the credits screen.

Decoding Symbols

This option provides help on decoding symbols.

Entering a Divisor

This option provides help on entering a divisor.

Intepreting Results

This option provides help on interpreting results.

Using Hypotheses

This option provides help on using hypotheses.

Reading the Status Area

This option provides help on reading the status area.

Using the Keypad

This option provides help on using the Keypad.
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The Mathematics of Divide and Conquer

Integer division is defined in mathematics through the division identity, around which
Divide and Conquer has been constructed.  The idea of an integer A being divided by an
integer B is actually defined according to multiplication and addition:  B divides A, yield-
ing a quotient Q and a remainder R if and only if

A= (B x Q) + R where

A, Q and R are non-negative integers, and B is a positive integer.

It is taken for granted that Q should be as large as possible and hence R should be as small
as possible and therefore always less than B.

One way to interpret the division identity is as a recipe for obtaining A given B, Q and R;
that is, you multiply B times Q and add R.  Actually, we usually think of integer division as
a way of getting a quotient and remainder from a dividend and a divisor.  But neither of
these interpretations fully captures the richness of the division identity.  Try to  think of the
identity as a general statement about the nature of integers.  The basic idea is that any
positive integer (A) can be expressed as an integral multiple (B) of any non-negative integer
(Q) plus some integer remainder (R).  For example 37 can be expressed as a certain number
of 8’s—precisely four 8’s—plus some integer remainder (5).  So the division identity can be
taken as an expression of how integers can be composed and decomposed from other
integers.

Students in the middle grades are already familiar with the idea that quantities (12 eggs, 24
miles, 2 hours) and numbers (12, 24, and 2) can be broken up—decomposed—and com-
posed.  In both school arithmetic and in everyday, informal mathematics, people use addi-
tive composition, although they do so in somewhat different ways.  For instance, in sub-
tracting 57 from 253, many people will mentally break up 57 into (53 + 4) and 253 into (200
+ 53); they then subtract 53 from 53; finally they subtract the 4 from the 200, obtaining 196
as their final answer.  In such a manner, a difficult subtraction is broken into a series of
more manageable steps.

The school approach is somewhat different, relying upon subtraction by columns. Column
subtraction of 253 – 57 works according to the following logic:

253 Because 3 is less than 7, 10 is borrowed from the tens column and added
- 57 to the 3. Seven is then subtracted from 13, giving 6.  Finally, 5 (representing
_____ 50 of the total 57) is subtracted from 24 (corresponding to the number 240).
196 This yields 19, which corresponds to 190.  The answer is 196.

Studies in informal mathematics have shown that children who can correctly manipulate
quantities in their head still may have trouble with the same numerical values when at-
tempting to solve problems through school methods.  Part of this difficulty seems to occur
because school-advocated procedures rely upon a system of place-value notation whereas
mental procedures often do not.  There seems to be a tension between the inherent
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meaningfulness of self-invented and informally learned representations and the potential
power and expressiveness of knowledge consistent with conventional, schooled representa-
tions.  With time, practice, and reflection, schooled representations can become more mean-
ingful and, consequently, more powerful.

The subtraction example was used to show that there are diverse correct ways of represent-
ing the “same” given problem. Furthermore, it shows that arithmetical problem solving
entails the decomposition of numbers and quantities.  But integers can be composed and
decomposed in other ways.  The idea that some quantities are multiples or factors of other
quantities appears to be widespread.  This case can be expressed by the equation A = Q x B,
which is clearly a special case of the division identity where the remainder is zero.  Any
student who has studied the multiplication table will understand that some numbers are
products of a pair of integer factors.  But the division identity takes this idea further:  it
allows us to represent any integer as a multiple of any other integer.

Another way of thinking of integers, implicit in the column subtraction example above, is
as multiples of powers of 10.  Three hundred forty-seven means three hundreds plus four
tens plus seven units.  Place-value notation captures this meaning in a particular way.
[347 = (3 x 100) + (4 x 10) + (7 x 1)].  A three-digit number, ABC, can be expressed in the
following way:

ABC = A x 100 + B x 10 + C x 1.

What does this have to do with Divide and Conquer?

Divide and Conquer is based upon the division identity, but that is only part of the story.
Divide and Conquer expresses unknowns not simply through letters A, B, and so forth, but
does so in a place-value fashion, so when a student looks at an example like

TW ÷ 10 → 8 remainder W,

the value of T can be deduced due to the fact that TW means (T x 10) + W.  This is one of
several important mathematical properties that Divide and Conquer brings to the fore. (Oth-
ers are discussed in “Learning with Divide and Conquer,” page 33.)

The idea of  “bringing to the fore” merits mention here.  To mathematicians one of the
defining properties of integer division is the fact that the remainder will always be less than
the divisor.  Now it is true that students who perform integer division correctly will not
violate the property; every time they divide, the remainder will be less than the divisor.
But it is one thing to fail to violate a property (which is guaranteed by performing the
division properly) and another thing altogether to be aware of it.

Our studies show that most 10- and 11-year-olds are initially unaware of the fact that the
remainder will necessarily be less than the divisor.  They make this perfectly clear when
they encounter a remainder expressed as an unknown and are asked to determine what
values it can take on.  Many students will argue that, for example, if you divide an un-
known number by 5, obtaining a single-digit remainder, that remainder can take on any
value in the range of 0 to 9.
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In the course of working with Divide and Conquer, however, they begin to suspect that large
remainders are unlikely or even impossible.  When this suspicion first arises they may not
be able to specify just where the cutoff lies. (Can division by 5 result in a remainder of 5?)

They may first only understand the constraint for the case of division by 2.  They may state,
for example, that even numbers leave 0 but odd numbers leave 1 as a remainder.  They
may have to consider several additional examples before formulating a general rule for any
integer divisor.

By presenting the remainder as an unknown to students, Divide and Conquer prompts them
to consider the range of possibilities that the remainder can take on. This is something that
doesn’t happen in everyday problems of division with a remainder, where a quotient and
remainder are derived from a known dividend and divisor.

Other Math Topics

The Division Identity upon which Divide and Conquer is based has important relations to
several basic important ideas, among them quotition, measurement, linear equations
(y = ax + b), and sharing.

Quotition is a form of division in which one asks how many pieces of a particular measure
(cost, length, weight) can be taken from a total quantity (total cost, total length, total
weight).  We can think of a problem in Divide and Conquer as corresponding to the question:
How many pieces (each the size of the divisor) can be taken from the original quantity (the
dividend)?

With regard to measurement, the link is as follows:  Given two commensurable measures
(measures with a common unit), a target measure and a smaller unit of measure, the target
measure can be expressed as an an integral multiple of the chosen unit of measure plus
some integral multiple of a secondary unit of measure.  (That's similar to saying that a
dividend can be expressed as an integral multiple of the divisor plus a certain number of
units—the remainder.)  One could go on to express the target measure through a mixed
fraction and this would of course lead discussion into the field of rational numbers, ulti-
mately one of the places the students must go.

Also directly related to the division algorithm are the Euclidean Algorithm for finding the
maximum common divisor and the concept of congruence.  The Phantom level of Divide
and Conquer can be taken as an embodiment of the Chinese Remainder Theorem.

For more ideas about how students learn to conjecture with Divide and Conquer, see the
following section,  “Learning with Divide and Conquer.”
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Learning with Divide and Conquer

How and what children can learn with Divide and Conquer can be best understood by
looking at interviews carried out with students as they work with the software.  By age 10,
most students have little difficulty going through the Demonstration and Rookie levels.
Performance on the remaining levels is partly a matter of previously acquired knowledge
and partly a matter of discovery.  Following are some mathematical ideas students can
discover with Divide and Conquer.  The examples show how insights can occur with and
without hints from teachers.

(In this section we draw on our research with 10- and 11-year-olds in Nottingham, England
and another group of students age 10 to 16 in Brazil.  The English group worked in pairs
for approximately 2 hours.  The Brazilian counterparts were interviewed in three weekly
sessions of roughly 1-1/2 hours each.  The students quoted by name in the following pages
were from the 10-11-year age range.)
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Inverse Perspective

Although Divide and Conquer is about division, division is also about multiplication; hence
Divide and Conquer is also about multiplication.  Let’s look a bit at the relationship between
division and multiplication.

Mathematicians define division with a remainder through multiplication.  The “division
identity” goes as follows:

Given non-negative integers A and B (where B is not zero), to say “B divides A” is to
assert that there exist non-negative integers Q and R such that A = (B x Q) + R.

To look at this from the perspective of division, we can say “A divided by B will yield
a quotient, Q, and a remainder, R.”

This switching between perspectives is required of students already at level 2 when they
play with Divide and Conquer.  At this level they face the fact that they cannot solve what
appears to be a division problem through division.  The reason is simple:  it is impossible to
derive a concrete result from the division of an unknown dividend by a known divisor.   “X
divided by 3,” for example, cannot be computed without knowing the value of X.
However, since at level 2 the answer (quotient and remainder) is known, one can discover
the dividend by inverting the operation.

Most children probably already understand the inverse perspective at some intuitive level
and become more aware of it through working with Divide and Conquer.  Children at age 10
typically are able to find the dividend using the divisor, quotient, and remainder at level 2.
Some start using inversion at the Demonstration level, where all values are known, or at
level 1, where dividend and divisor are known and quotient and remainder are unknowns.
For example, when Risvan, one of the English children we observed, divided “WS” by 26,
obtaining “quotient 3, remainder 6,”  he responded that WS was 84, explaining that he
“added three 26s, getting 78 and then added 6.”

Some children, however, initially ignore the role of the remainder, treating the dividend as
equal to the quotient times the divisor.  The following excerpt shows how, after several
failures, the complete solution occurred to Simon and Claudius.

Problem: MS ÷ 2 → 34 remainder 1.

Simon: 34.  Two 34’s are 68.  So that  [M] is 6 and that [S] is 8.

Claudius: 8.  Where’s 8?  Right.  There’s 8. [The computer doesn’t accept 8 as value
of S].  No!  It’s not 68.  Isn’t it...it’s got remainder 1, so it’s 69!
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Remainder Smaller than Divisor

For all cases of division with a remainder, the remainder must be less than the divisor.
Mathematicians treat this as a defining property of division with a remainder.  As a rule,
students will gladly perform integer divisions without noting this fact.  When questioned
about the relative size, they will commonly remark that “the remainder could be
anything.”   Maria Helena and Suely’s comments are typical:

Problem: XL ÷ 2 → 12  remainder B.

Interviewer: How large do you think the value of B could be?

Maria Helena: It could be 0, 1, 2, 3, 4, 5...

Interviewer: Could it be as much as 9, this B?

Maria Helena
    and Suely: Yes.

Interviewer: Could it be any number?

Suely: Yes.

In the course of working with Divide and Conquer, students begin to suspect that the
remainder cannot be just any number.  This suspicion often arises with division by two.
Most children know that even numbers are divisible by 2 and have no remainder whereas
odd numbers will leave 1 as the remainder.

Problem: BC÷ 2 → 44 remainder D.

Nicola: [BC is] 88.

Clare: It can’t be because they [B and C] are different.

Nicola: 89.

Interviewer: Could D be another [number]?

Nicola: No, because if it were another one it [the quotient ] would be 45....  D is
definitely a 1.

[Note that D cannot be 0 since BC cannot be 88.]

For most children, discovery of the principle is a slow process, as it was for Maria Helena
and Suely.  Let’s look at their reasoning at a later point in their interview:

Problem:  KJ ÷ 2 → 9 remainder M.

Maria Helena: M may be 0, 1, 2, 3, 4, 5, 6 and 7.

Interviewer: Let’s check to see if M can be 2.
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Maria Helena: 2 times 9, 18; and 2, makes 20.  It could be 2.

Interviewer: If M is 2, how much is KJ?

Maria Helena
and Suely: 20.

Interviewer: And if you divide 20 by 2, what do you get?

Suely: It makes 10; 10 times 2 is 20.

Maria Helena: I was making it like this:  2 times 9, 18.  If M were 2 it would be 20,
right?

Interviewer: But when we make 9 times 2 it makes 18, and 2 is left out.

Maria Helena: M could be 1 because then we would have 19, and 19 divided by
2 is 9.

Interviewer: M can’t be 2?

Maria Helena
and Suely: No.

Maria Helena: M could be either 0 or 1.

Interviewer: Couldn’t it be 2?

Maria Helena: No.

Interviewer: Could it be 3?

Maria Helena: No, 9 times 2, 18; plus 3 is 21.

Interviewer: And what if M were 4?

Maria Helena: It can’t be.

Interviewer: Why couldn’t the remainder be 2, 3 or 4?

Maria Helena: Because then the quotient will be larger than 9.

The discussion above shows the two students discussing the possible values of the
remainder given the divisor is 2 and the quotient is 9.  They realize the remainder couldn’t
be as large as 2 because this would produce a quotient of 10, which is contrary to what they
know; namely, that it is 9.  Other children resolve the case of division by 2 by noting that
even numbers leave nothing and odd numbers leave a remainder of 1 when divided by 2.
However, we can not assume that just because they recognize that the divisor 2 can only
have remainders of 0 or 1, children will necessarily extend the principle to other divisors.
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With time and reflection, they move from a restricted “scope of validity” to the more
general case:

Problem: MM ÷ 2  → J remainder R.

Interviewer: Can the remainder be equal to 4?

Maria Helena: No.

Interviewer: If you divide by 2 what are the possibilities for the remainder?

Maria Helena: 0 or 1.

Interviewer: Why can’t it be 3?

Suely: Because the remainder can’t be greater than the divisor.

Interviewer: Why not?

Maria Helena: Because then we could divide once more into it.

Interviewer: So if you were dividing by 6, what are the values that the remainder
could be?

Suely: 0, 1, 2, 3, 4, 5.

Summarizing, the remainder is always less than the divisor, but students tend not to notice
this property when carrying out division.  In Divide and Conquer, however, they have to
consider the values the unknown remainder can take on.  The situation encourages them to
reflect about the issue.
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The Special Properties of 10

Several interesting properties arise from the fact that we use a place-value decimal system
in writing numbers.  A number written as 73 means 7 tens and 3 units.  Now, if 73 is
divided by 10, the quotient will be 7 and the remainder will be 3.  Knowing this property
can be useful in Divide and Conquer when the dividend is not known.  There are three
relevant ideas here:

MU ÷ 10 yields quotient 7 remainder U implies M=7.

MU ÷ 10 yields quotient M remainder 3 implies U=3.

MU ÷ 7 yields quotient 10 remainder U implies M=7.

The first expression states that a 2-digit number, when divided by 10, will have the tens-
column value returned as the quotient.  The second states that the units-column value will
be the remainder.  And finally, the third states that a division of a 2-digit number by a 1-
digit number, yielding 10 as the quotient, means the tens-column value is equal to the
divisor!

Below is an example of the first property being discussed by two English 11-year-olds.

Problem: AB ÷10 → 4 remainder B.

Ashish and Risvan argue with conviction that A equals 4, but they can’t explain why.

Risvan: Why do you think the letter A’s number is there [pointing to the number 4
in the place where the quotient is always displayed]?

Ashish: Because A is first...and that’s probably why I think it’s...

Risvan: But does the first number always come out here [pointing] whenever you
divide by something?

Ashish: I don’t know.  That’s what we don’t know.

The students’ reasoning is indeed correct:  The letter A can only stand for the number 4.
Note, however, that their intuition is ahead of their justification. They know they can
deduce something, but it is not certain why the deduction is legitimate.

Even if students don’t have a preconceived intuition about properties associated with
divison by 10, they can come to discover the properties by considering several examples:

Problem: BX ÷10 → B remainder 8.

Carolina: What’s a number that, when divided by 10, gives a remainder of 8?  That’s
difficult!

Julieta (divides 28 by 10 on paper): Go ahead, do it (the division), Carol.

Carolina: It’s 2 and there’s 8 left over.
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Julieta: But it could be various numbers.  If I use 48 it will give a remainder of 8; if
I use 58, it’ll give 5, remainder 8.  (They both laugh.)  Don’t you see, Carol?

Interviewer: And so what do you conclude from that?  You divided 58 by 10 and got 5,
remainder 8.

Julieta: (Insight comes.)  It’s this number here (BX) that must end in 8!

Interviewer: Why do you conclude that, Julieta?

Julieta: Because the rest can only be...because a number ending in 8 divided by 10,
the remainder can only be eight.

Interviewer: And if the number ended in 6 and was divided by 10?

Carolina: It would give 6 (as the remainder).

At first it seems that nothing can be concluded from the fact that a particular division by 10
yields 8 as the remainder.  However, as Carolina and Julieta begin to consider the numbers
that leave 8 when divided by 10, they note that the dividends which “work” have in
common a units-column value of 8.  Eureka! There seems to be a general rule that can be
inferred from the particular cases.
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Identity Properties

Division by 1 and division by the dividend itself are special cases students draw upon at
certain levels to break codes.  Two basic cases are exemplified below:

AT ÷ AT yields quotient X remainder W implies X=1, W=0.

AT ÷ 1 yields quotient 39 remainder W implies A=3, T=9, and W=0.

The first principle states that a number divided by itself gives a quotient of one and a
remainder of zero.  The second principle states that dividing a number by one yields the
number itself as the quotient with a remainder of zero.

These principles are often surprisingly elusive.  Children occasionally use the first principle
spontaneously in order to discover the codes for zero and 1, as Taciana notes when she
proposes to divide BM by itself:  “I was thinking about dividing by BM because there
wouldn’t be any remainder and the result would be 1.  Then we would know what was 0
and 1.”

Surprisingly, children don’t often think about dividing by 1.  Perhaps children do not
consider dividing by 1 division at all.  Use of the principle must then be encouraged by the
teacher.  As Taciana and Rodrigo showed, when they worked at level 2 (Apprentice), a
suggestion by the interviewer leads to a discovery of the principle.

Problem: The dividend given by the computer was TH and, for previous dividends, the
children had used all single-digit numbers as divisors, except 1.

Interviewer: You’ve already divided by 9, 8, 7, 6, 5, 4, 3 and 2.  What would you get if
you divide by 1?

Rodrigo: It doesn’t help, because then you would have TH.  Oh, no...

Taciana: You would have the result.  It will tell what that number is.  It will give
the values of T and H and the remainder will be 0.
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Two Special Cases

Divisor Larger than Dividend

Dividing by a number larger than the dividend will produce a quotient of zero and a
remainder equal to the dividend itself.  This property can be used to ascertain the value of
an unknown dividend.  For instance, the information that “AG divided by 75 yields 0,
remainder 23” implies AG must be equal to 23.

In level 4 (Expert), choosing a relatively large divisor such as 99 will expose the dividend’s
value as the remainder.  While this may seem mathematically trivial, it was often far from
obvious to the students, who displayed surprise and confusion about the meaning of the
operation.  Even though Risvan and Ashish had no difficulties up to a certain point; they
were confused that dividing ZX by 50, 60, 70, 80 and 90, yielded “quotient 0, remainder 23”
each time.  This uncertainty did not disappear when they finally discovered the value of
ZX.  In fact, their final explanation is that divisors “higher than 20” will leave the value 23
in the remainder.  We have even observed adults who are puzzled by the fact that division
by diverse divisors can lead to the same results.  Many people seem to feel that each
division of the same dividend by different divisors should yield unique results.  This does,
in fact, hold true for calculator division but not for division with a remainder.

Divisor Larger than Half the Dividend

When the divisor is larger than half the dividend but equal to or less than the dividend, the
result of the division will be 1, and the remainder is the difference between the divisor and
the dividend.  This can be useful when the dividend's value is already known.  For
example, if LH is known to be 94, then dividing by 89 will produce a remainder of 5, since
94-89=5.  If the remainder is coded then 5 will be the value of the corresponding letter.
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 Division with a Remainder vs. Division with a Calculator

In the context of sharing or distributing things, even young children understand the idea of
a  remainder as referring to that part of the original quantity that is left over.  When the
leftovers are numbers (5, 32, 17) rather than measured quantities (5 candies, $32, 17 miles),
the meaning of the remainder—where it comes from and how it relates to the dividend and
divisor—is not always clear.  Students will occasionally use calculators to assist in verifying
their calculations.  This can be a splendid opportunity to explore their understanding of the
relationships between division with a remainder (Divide and Conquer’s way of dividing)
and hand-calculator division, which expresses results as a decimal number quotient while
ignoring the remainder, if there is one.

There are important differences between a remainder, as we have used the term until now,
and the remainder of division on a calculator:  a remainder on a calculator is always a
number less than one, and is never displayed.

For example, if we divide 17 by 3 on a calculator which keeps track of, say, only three digits
to the right of the decimal point, the answer will be shown as 5.666 (or 5.667 if rounding is
done).  Since the complete quotient is 5.6666666...(extending forever), the remainder is the
difference between the quotient shown and the correct quotient.  The value of the
remainder for the unrounded case will be 0.0006666....

Now let’s look at two Brazilian fifth grade students discussing the two types of division.

[Pedro and Tais have just noted that 89 divided by 2 will yield 44 remainder 1 on the
computer.]

Interviewer: If I divide (89 by 2) on the calculator I get the same answer, right [pointing
to 44.5 on the calculator]?

Tais [shaking her head]:  No, I think that (on the computer) 1 was left over and
here [pointing to the right part of the answer, that is, to .5] it’s half of one.

Interviewer: This point-five is half of one?  Do you think it’s the same thing, Pedro?

Pedro: Is five half of one?  Does one have a half?

Interviewer: Explain it to him, Tais.

Tais: I thought like this.  Here (in Divide and Conquer) it gave 44 with 1 left over
and there (on the calculator) this point-five is one half.  Forty-four and one
half and (the computer) had forty- four remainder one.

Pedro: Ah! Now I get it.  One half of 1 is one-half and that’s equal to 5.

Pedro seems to be uncertain about the meaning of the 5 in the present context but is
willing to agree with Tais that it means one-half.

Interviewer: [moving to another example]:  And now, 80 divided by 7...gave 11
remainder 3 (on the computer).  Now let’s try it out on the calculator.
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Pedro (transposing the former example literally to the case at hand): It’s going to
be point, um, five.

Interviewer: Why are you telling me it’s going to be (eleven) point five?

Pedro: Because half of three is one and a half.

[Calculator shows  11.428571 as the answer.]

Pedro: This thing here (.428571) is half of three.

The interviewer comes to the rescue.

Interviewer: Really?  Are we dividing in half or not?  Isn’t the problem 80 divided by
seven?

Tais: I can’t explain that.

Pedro: It must be half of 3.

Tais: No way!   All this (.428571) can’t be half of 3.

Pedro: So...?  I thought that this here (.428571) taken three times would give 3, but
that’s not right.

Pedro has reasoned correctly that if the decimal fraction is the result of a division of the
number 3, then multiplying the value should return the value 3.  This is basically correct,
but he has not seen yet that three is not the number to multiply the decimal fraction by.

Second
Interviewer:  So where does this (.428571) come from?

Students: (no reply)

Interviewer:  You are saying that that is a little piece of three, but what piece is it?

Pedro: That 7 has got to have something to do with it.

Interviewer: What do you think it has to do with it?

Pedro: This here (.428571), seven times, gives us the 3.

Pedro has now solved the puzzle.  He knows that the fractional part of the quotient, when
multiplied by the divisor, will return the value of the remainder of integer division.
Regardless of whether he understands the intricacies of decimal number notation, he does
grasp the fundamental relationships among the diverse mathematical objects involved in
division with a remainder and ordinary division.
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Hypotheses and Deductions

Up to this point we have focused most of our attention upon the mathematical properties
students have discovered or clarified while using Divide and Conquer.  More important than
the mathematical content per se are the processes by which students reason and gain
insight into mathematics.  These are certainly more difficult to characterize objectively but
they merit discussion nonetheless.

All children we have observed using Divide and Conquer reason about abstract numbers and
their interrelations.  While it is true that all children are attempting to discover the values of
unknowns, they do so in varying manners or styles.  The simplest approach consists of
sequentially testing particular hunches—whether A is 2, or B is 7, for example.  Students
may feel perfectly satisfied with one or two checks to see if their hunch is correct.  If the
data are consistent with the hunch, it is accepted and tried out.

A more abstract approach entails thinking about the full range of possible hypotheses.  At
the beginning of a trial with Divide and Conquer, any symbol could stand for any digit from
0 through 9.  Each time new information is obtained regarding the mathematical objects,
students using this approach will reduce the set of possibilities, gradually converging on
single values for each symbol.  Let’s look at an example.

Problem: BM ÷ 5 → T T remainder R.

Elisa and Ana immediately state that T can only be 1 or 2.  Ana writes

11 x 5 = 55 on paper and then 22 x 5 = 110.

Interviewer: What do you conclude from that?

Ana: (BM) can only be 55...Wait a minute.  There’s still R to take into account.  T
can only be 1.

Interviewer: Are you sure?

Ana: Because otherwise BM would be 110 (a 3-digit number)....  Going back, M
can only be 4 or 5.  Now M can be 5 or above because we saw that BM
must be at least 55.   M can only be 6 or 8.

Interviewer: Why?

Ana: We already know that BM is 55 plus R.

Interviewer: Can’t M be 9?

Ana: No, because we know that it is even.

[Note: in an earlier division, they divided BM by 2 and discovered the remainder to
be zero.  Hence, BM is even and so is M.]

Interviewer: What about B?
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Ana: It can be 4 or 5.  B can't be 4.

Interviewer: Why not?

Ana: Because 11 times 5 is 55.  B is 5.

Elisa: Ana!  B is 5.

Interviewer: And M?

Elisa: M can be 6 or 8.

Ana: M can’t be 6 because T is already known to be 1.  [So R can’t be 1.]...So M
is 8.

Elisa: I never thought I could discover an answer without having been given
any number!
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Hints for Levels 5 (Ace) to 8 (Phantom)

Hints for level 5 (Ace)

Students may be perplexed when confronting level 5 for the first time because the divi-
dend, quotient and remainder are all in code.  Here are two hints:

1.  Remember that it is legal to divide by symbols.

2.  Think of what happens when a number is divided by 1.  What happens if a num-
ber is divided by itself?

Hints for level 6 (Wizard)

Dividing by 1 is once again useful.  Dividing by letters would also be useful, but this is not
allowed at this level.  Try dividing by 2 and then by 5 and see what turns up.  What next?

Hints for level 7 (Inspired)

No symbols at all are given in the answer.  We only find out how many digits are in the
quotient.  The remainder is given as a known, but what can be done about that?

Dividing by big numbers can be helpful here.  Suppose, for example, dividing TAW by 99
leaves a remainder of 83.  What numbers could TAW be?  Write them all down.  (It's not so
difficult.  There are fewer than 10 such numbers!)  Once the possibilities have been nar-
rowed down, think:  What further divisions could eliminate some possibilities from the
list?  Once the possibilities are whittled down to just one number, that number is the an-
swer.

Hints for level 8 (Phantom)

The hints for level 7 continue to be useful here.  The only difference is that no information
about the size of the quotient is given.  Remember to request a new dividend if needed. It
may be helpful to express information that has been obtained so far in the form of equa-
tions.
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Student Pages
In this section there are several reproducible pages for students.

Divide and Conquer Jot Sheet (p. 48)

Provide students with several copies of the Jot Sheet so they can make calculations and
conjectures on paper while working with Divide and Conquer.  Or you might want them to
use their own paper for a few sessions, then turn in a completed Jot Sheet for an official
record of one session at each level.

Off-Computer Problems (pp. 49-51)

After students are familiar with Divide and Conquer, introduce similar off-computer prob-
lems to help them formulate strategies when back at the computer.  The problems here
range from fairly easy (the first set) to difficult (the third set).

Calculator Problems (p. 52)

These problems will help students compare division with Divide and Conquer with division
by calculator.  (For an example of beginning students thinking along these lines, see
“Learning with Divide and Conquer,” page 33.)

Divide and Conquer Questions (p. 53)

Also provided in the Student Pages is a reproducible page called Divide and Conquer Ques-
tions, which you might want to give to students working independently.  While some
students might profit from this list of leading questions, others might learn better with just
an occasional strategic question from you, so you decide whether the Question Sheet will
help individual students or groups.

Another option:  Let partners or cooperative groups brainstorm a list of helpful questions
on their own, then compile these into a customized Question Sheet for the class.

Divide and Conquer Score Sheets (pp. 54-61)

Students can use these pages to keep track of their progress at each level.
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Divide and Conquer Jot Sheet

At what level are you working? ____________________________________________

What's in code at this level?

Dividend____    Quotient____    Remainder____

Keep track of guessed letters.

What do you know?   Before you choose a new divisor, write down unsolved facts from
old problems that may be useful for new problems.

Calculations

What strategies work best at this level?

Best Session

Level________________ Hits______ Misses_______ Clues_______

Student:

0 1 2 3 4 5 6 7 8 9
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Off-Computer Problems — Set 1

1.  AA is divisible by what whole numbers? [Think: how many A's are there in AA?]

2. TY ÷ 10 → T remainder 3.  What is the value of Y?  Explain your answer.

3. If MR ÷ 5 → G remainder 2, then there are only two possible values for R.  What are
those values?

Student:
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Off-Computer Problems — Set 2

1. If QP ÷ 11 → A remainder A, then QP must be divisible by five distinct numbers, all of
which are integers.

What are those numbers?  [Hint: How many A’s are there in QP?]

2. BR ÷ 4 → a quotient with two digits and a remainder of 3.

BR ÷ 13 gives a one-digit quotient and a remainder 8.

What is the value of BR?

[Hint: There are only 8 numbers between 0 and 99 which satisfy the second condition
listed above (i.e., when divided by 13, they give a remainder 8).  Find those first.]

Student:
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Off-Computer Problems — Set 3

1. If MX ÷ A → 3, remainder 1, then it is possible that MX ÷ 3 will yield A, remainder 1, but
this is not always true.

When is it false?

[Hint:  Try it out for a number of values, and try to determine when the rule does not
follow.]

2. (a) RP ÷ NL → 1, remainder 17.

By how much would you have to increase NL to get it to be equal to RP?

(b) HY ÷ NL → 3, remainder 9.

By how much would you have to increase NL to get it to be equal to HY? [Hint:
Complete this equation first:  HY = 3 x ? + ?.]

Student:
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Calculator Problems

1. A friend enters a whole number between 15 and 20 on a pocket calculator without
revealing the number to you.  He divides that number by 3 and obtains an answer
which ends with .6666666.

You do not know what numbers are displayed to the left of the decimal point.  What
number was originally entered into the calculator?  (In other words, what is the
dividend?)

2. A friend enters a whole number between 270 and 400 on a pocket calculator without
revealing the number to you.  She divides that number by 120 and obtains an
answer which ends with .25.

You do not know what numbers are displayed to the left of the decimal point.  What
number (dividend) was originally entered into the calculator?

3. A friend enters a whole number between 100 and 200 on a pocket calculator without
revealing the number to you.  He divides that number by 97 and obtains an answer
which ends with .9587628.

You do not know what numbers are displayed to the left of the decimal point.

(a) What number (dividend) was originally entered into the calculator?

(b) How can you solve this problem without dividing?

Student:
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Divide and Conquer Questions

At some levels of play the answers to these questions will help reveal portions of the codes,
but at some levels they won’t!  It’s your job to figure out the most elegant—and fastest—
way to break the code.

What happens if you divide by 1?

What happens if you divide by 2?

What happens if you divide by 5?

What happens if you divide by 10?

What happens if you divide by the number itself?

What happens if you divide by a number with more digits than the dividend?

If you know the dividend, what happens if you divide a number larger than half the
dividend?

What happens if you divide by the symbol in the tens column of the dividend?

Does it help to divide by symbols?

Can you whittle down the possibilities?  Write down all the numbers from 0 to 999
that your unsolved number could be.

Does asking for a new dividend help you?

Does using the Hypothesize option help?

Student:
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Divide and Conquer
Rookie Level Score Sheet

Strategies for Rookie Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Score Sheets

Student:
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Apprentice Level Score Sheet

Strategies for Apprentice Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Master Level Score Sheet

Strategies for Master Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Expert Level Score Sheet

Strategies for Expert Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Ace Level Score Sheet

Strategies for Ace Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Wizard Level Score Sheet

Strategies for Wizard Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Inspired Level Score Sheet

Strategies for Inspired Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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Phantom Level Score Sheet

Strategies for Phantom Level

Hits Misses Clues

Session 1

Session 12

Session 10

Session 9

Session 7

Session 6

Session 5

Session 4

Session 3

Session 8

Session 11

Session 2

Student:
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